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CC دبلومة الجرافيكساليستريتور 

ITC جميع حقوق الطبع و الملكية الفكرية محفوظة لشركة ITC أبراج الفالكون - عجمان -الامارات العربية المتحدةأبراج الفالكون - عجمان -الامارات العربية المتحدةجميع حقوق الطبع و الملكية الفكرية محفوظة لشركة

ابراج الفالوكن B1 الطابق 21 ,الراشدية , عجمان , الامارات العربية المتحدة

:  ITC تعريف بشركة
      شــركة انترناشــونال للتدريب و الاستشــارات ITC و مقرها 
ــها  ــدم نفس ــدة تق ــة المتح ــارات العربي ــة الأم ــان بدول عجم
ــد مــن المؤسســات  ــرة و شــريك للنجــاح مــع العدي ــت خب كبي

ــة و الشــركات و الأفــراد فــي مجــال التدريــب  الحكومي
و الاستشــارات و الحلــول المتكاملــة مــن خــال منهــج علمــي 
ــز  ــا يمي ــة مم ــزة و محترف ــرات ممي ــي و خب ــل مؤسس و عم
عملاؤنــا و يعطيهــم الأفضليــة العلميــة و العمليــة و يؤهلهم 
لتنميــة مهاراتهــم بمــا يتوافــق مــع متطلبــات ســوق العمــل .

رؤية الشركة : 
ــار الأول و  ــا الاختي ــا ممــا يجعلن      تحقيــق الثقــة لــدي عملاءن
الأفضــل في مجــال التنمية البشــرية و الأداريــة و الجرافيكس 

و المالتيميديــا .
البرامج التدريبية : 

تقــدم شــركة ITC  للتدريــب و الاستشــارات العديــد مــن برامج 
التدريــب المتكاملــة فــي مجــال التنميــة البشــرية و الاداريــة و 
الجرافيكــس بأعلــي معاييــر الجــودة التدريبيــة و ذلــك لتحقيــق 

أقصــي اســتفادة علميــة و عمليــة ممكنــة
المادة العلمية 
م/ أحمد ابراهيم

وصف الدورة

مدة الدورة

متطلبات الدورة

أهداف الدورة

Course Description

Course Duration

Course Objectives

Course requirements

 CC من خلال هذه الدورة سنقوم بدراسة برنامج اليستريتور 
و هو البرنامج الاول  في تصميم اللوجوهات و تصميم المطبوعات بكافة 

انواعها الي جانب رسم الخرائط و الانفوجرافيسك و نضيف الي هذه المزايا 
.. التكامل بينه و بين برامج أدوبي الاخري مثل الفوتوشوب و الانديزاين و 

الفلاش. سنقوم بتغطية كل ما يساعد المصمم في الحصول علي منتج 
 طباعي متميز

مما سيمكنكم ان شاء الله للوصول الي احتراف العمل علي البرنامج بكافة 
اوامره من خلال التطبيقات و الشرح الموجودين داخل الكتاب أو من خلال 

متابعة المحاضرات و التطبيق العملي . 

• التعرف علي اهمية برامج الـ Vector و مميزاتها في الرسم عن 	
البرامج الاخري مثل الفوتوشوب .

•  كيفية استخدام البرنامج في تصميم لوجو 	
•  التعرف علي المميزات التصميمية للبرنامج في تصميم كافة 	

انواع المطبوعات 
•  التعرف علي مميزات البرنامج في رسم و تلوين الشخصيات 	

30 ساعة مقسمة الي 10 محاضرات ) كل محاضرة 3 ساعات ( 

الألمام الجيد باستخدام الكمبيوتر و الويندوز .

ITC جميع حقوق الطبع و الملكية الفكرية محفوظة لشركة
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 المحاضرة الاولي 

أهداف المحاضرة
• 	CC التعرف علي الواجهة الرئيسية لبرنامج الاليستريتور

 Menu bar 1.شريط القوائم 	
Panels  2. اللوحات 	

Tools 3. الأدوات 	
Control Panel 4. لوحة التحكم 	

Workspace 5. مساحة العمل 	
Document window 6. مكان التصميم 	

•  أساسيات العمل مع البرنامج	
• 	Vector & Raster
• 	Selection tools
• 	Group
• 	Isolation mode
• 	Fill & Stroke
• 	Layers

• 	New Document فتح ملف عمل جديد 
Bleed معني كلمة 	 

Artboard اللوحة الفنية 	
• 	Ruler & Guides 
• 	Smart Guide
• 	Zoom tool
• 	Hand tool
• أدوات رسم الأشكال الأساسية	

الرموز و الاصطلاحات

المقصود به  الرمز

 ملحوظة هامة

تطبيق بشكل عملي تحت اشراف المحاضر

تطبيق عملي 

 اختصار لوحة مفاتيح
keyboard shortcut

معلومة إضافية هامة

الخلاصة
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 تحتوي القوائم علي كل أوامر البرنامج 
وكل قائمة من القوائم يدل اسمها علي المهام الخاصة بها

و سوف نلاحظ ان بعض الاوامر 
يوجد بجانبها اختصار لوحة 

 المفاتيح كما هو موضح بالصورة 
keyboard shortcut

 Menu bar 1.شريط القوائم 

File > New  Ctrl + N

Panels  2. اللوحات

كلمة panels معناها لوحة أو نافذة صغيرة تحتوي علي أحد أوامر 
البرنامج و التي توكن موجودة في القوائم .

Panels

ExpandDocked

IconFloaten

اللوحة مفتوحة
مدمجة مع 

الواجهة الرئيسية

موجودة بشكل حر اللوحة مغلقة
 Panels  كل الـ

 موجودة في قائمة 
Window

panels تابع مع المحاضر كيفية التعامل مع الـ

Adobe Illustrator CC
تعريف بالبرنامج

برنامج ادوبي اليستريتور Adobe Illustrator هو برنامج رسم و تلوين و له 
مميزات رائعة في تصميم اللوجوهات و تصميم المطبوعات بكافة انواعها الي 

 جانب رسم الخرائط و الانفوجرافيسك و تصميم الملابس و الاقمشة 
و نضيف الي هذه المزايا .. التكامل بينه و بين برامج أدوبي الاخري مثل 

الفوتوشوب و الانديزاين و الفلاش. 

Interface الواجهة الرئيسية

تتوكن الواجهة الرئيسية لبرنامج الاليستريتور  من ستة أجزاء رئيسية
11. Menu bar شريط القوائم 
22.Panels  اللوحات 
33.Tools الأدوات 
44. Control Panel لوحة التحكم 
55.Workspace مساحة العمل
66.Document window مكان التصميم 

 Menu bar شريط القوائم  Control Panel لوحة التحكم 

Workspace مساحة العمل

Panels اللوحات

Tools الأدوات Document Window مكان التصميم

المحاضرة الأولي المحاضرة الأولي
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 Control Panel 4. لوحة التحكم

يجب أن نأخذ في الاعتبار ملحوظتان هامتان جداً عند التعامل مع الادوات في برنامج 
الاليستريتور 

Tear off.1 فصل الادوات :

2. دبل كليك علي أي أداة لاظهار إعدادتها :

عندما نقف علي أي أداة و نظغط كليك و نسحب حتي نصل الي السهم 
الموجود في اقصي يمين مجموعة الادوات ..في هذه الحالة سنفصل 

هذه المجموعة من الادوات كما موضح .

 مثال : 
إذا ضغطنا دبل كليك علي أداة الـ Rotate tool ستظهر إعدادات الاداة 

كما هو موضح

 تعتبر الجزء الأهم في الواجهة الرئيسية للبرنامج 
فمن خلالها نستطيع التحكم في كثير من اعدادات الادوات و تسهل علينا العمل 

 دون الحاجة الي التنقل القوائم 
و يتغير شكل الـ Control Panel مع بعض الادوات.

مع معظم الادوات

Artboard tool مع أداة الـ

Type tool مع أداة الـ

Tools 3. الأدوات 

 سيتم شرح كل مجموعة من الأدوات من خلال الموضوع الخاص بها

Direct selection tool
Lasso tool

selection tools

Type tools

Prespective tools

Shape tools

Pencil tools

Cutting tools

Scale tools

Free transform tool

Gradient tool
Blend tool

Graph tool

Slice tool

Zoom tool

Magic wand tool

Line tools

Paint Brush tool
Blob Brush tool

Rotae & Reflect tools

Width tool & Liquify tools

Path creation tools

Shape builder tool

Mesh tool

Symolism tools

Artboard tool
Hand tool

المحاضرة الأولي المحاضرة الأولي
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Document window 6. مكان التصميم

المنطقة التي 
 سيتم طباعتها 

Artboard

Canvas

Workspace 5. مساحة العمل

 panels هي عبارة عن مجموعة معينة من الـ workspace مساحة العمل أو الـ 
مرتبة بشكل معين لتناسب مع طريقة العمل أو المشروع الذي نعمل فيه 

قم بتنسيق الـ panels بالشكل المناسب لك

لعمل مساحة عمل 
جديدة :

الطريقة الأولي  
سنجد قائمة في 

أعلي يمين الواجهة  
الرئيسية و نختار 

 منها 
New workspace

الطريقة الثانية

window > workspace > New workspace   نختار من قائمة

 لإلغاء مساحة عمل 
من نفس المكان الذي أنشأنا فيه مساحة 

 عمل جديدة 
 Manage workspace هذة المرة نختار

ثم نحدد ما نريد الغاؤه و نضغط علي 
ايوكنة سلة المهملات 

 لاعادة مساحة عمل لترتبيها الأصلي  
من نفس المكان الذي أنشأنا فيه مساحة 

 عمل جديدة 
Reset workspace هذة المرة نختار

كلمة Artboard معناه مساحة العمل التي ستظهر في الطباعة و التي نقوم بوضع 
عناصر التصميم فيها و سيتم شرحها لاحقاً بشكل مفصل .

المحاضرة الأولي المحاضرة الأولي
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أساسيات العمل مع البرنامج 

Vector & Raster.1
Selection tools 2.  أدوات التحديد

Path رسم توضيحي للـ هام جداً جداً

11.Vector & Raster
22.Selection tools
33.Group
44.Isolation mode
55.Fill & Stroke
66.Layers

 هذه الأساسيات الخمس هي الاهم علي الاطلاق 
وفهمها و استيعابها سيسهل علينا الكثير لفهم 

طريقة عمل البرنامج 

Vector و Raster
كلمتان في غاية الأهمية و يجب معرفة معني كل كلمة منهما قبل التعامل مع 

اي برنامج تصميم أو مع الجرافيسك بشكل عام.

RasterVectorالمصطلح

الشرح

صورة أو شكل تتوكن من 
بكسلات و ترجع جودة الصورة 
للـ Resolutionو تتأثر الصورة 
عند التكبير أو التصغير و يحدث 

لها تشويه عند تكبيرها عن 
حجمها الأصلي 

شكل يتوكن من خطوط 
) Paths ( مستقيمة أو منحنية
مرتبطة ببعضها بنقط تحكم 

 Anchor points تعرف بـ 
و هي لا تتأثر بالتكبير أو 

 التصغير و تتميز أشكال
 الـ Vectorبالحواف الحادة و 

الناعمة .

نموذج

Photoshopالبرامج
Illustrator
Indesign

Corel draw

الأداة 
Selection tool 
 السهم الاسود

Direct selection tool 
 السهم الابيض

تحديد نقطة Anchor Point تحديد كل الـ Pathالوظيفة
او اكثر 

ملحوظة 
هامة

تعمل أداة السهم الاسود 
 Transform كأداة تحريك و

في نفس الوقت .

لا يقتصر استخدام أداة السهم 
An�  الابيض فقط علي تحديد 
chor point  و انما تستخدم 

في التعامل مع أجزاء من 
اشكال مرتبطة ببعضها مثل 

 Clipping أو Group جزء من
 blend أو mask

 كما نري في هذا الشكل 
 أن الـ Path يتوكن من ثلاثة أجزاء 

 Path جسم الـ 
Anchor point 

 Handle ذراع تحكم Path جسم الـ

Anchor point

ذراع تحكم 
 Handle

معني التحديد في الاليستريتور يختلف عن الفوتوشوب فالمقصود بالتحديد هنا 
هو تنشيط شكل أو كلمة لتنفيذ أحد أوامر البرنامج عليه

 لدينا أداتان في غاية غاية الأهمية و هما :
 Selection tool .1 ) السهم الاسود ( 

Direct Selection tool .2 ) السهم الابيض (

المحاضرة الأولي المحاضرة الأولي
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• 	Selection tool لتحديد شكل ما كل مع علينا هو اختيار أداة الـ 
) السهم الاسود (  و نضغط كليك علي الشكل الذي نريد تحديده

• 	 Marquee لتحديد أكثر من نشكل نستخدم مايعرف بالـ 
كما هو موضح بالصورة .

•  لعمل نسخة من شكل أو اكثر أو كلمة	
 نحدد العنصر أولا باداةالسهم الاسود
 Edit من قائمة Copy ثم نختار ألامر

• و لتحديد اكثر من عنصر بشكل منفصل نضغط كليك باداة السهم الاسود 	
علي أو ل شكل ثم نضغط Shift + كليك علي الشكل الثاني .

1

2

نضغط كليك و نسحب من هنا 

حتي هنا

1. كليك Shift .2 + كليك

Ctrl + C

Group.3

Group كيفية عمل

كلمة Group معناها مجموعة من الأشكال مرتبطة ببعضها لوجود علاقة 
تصميمية بين هذه الاشكال كمجموعة من الورد أو مجموعة من الكلمات نريد 

تحريكها أو تكبيرها أو تصغيرها معاً

1. نفتح ملف العمل  group الموجود في ملفات عمل المحاضرة الاولي 

2. نحدد الأشكال التي نريد تجميعها في 
 Group بالسهم الاسود

Object من قائمة group 3. نختار الامر

• من الممكن عمل Group عندما نقف كليك 	
Group يمين و نختار الامر

• لفك الـ Group نحدد الـ Group بالسهم 	
Ungroup الاسود نقف كليك يمين و نختار 

Object و نفس الأمر سنجده في قائمة

المحاضرة الأولي المحاضرة الأولي
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Isolation mode 4. العزل Fill & Stroke .5

Layers 6. الطبقات

معني كلمة Isolation mode هي عزل عنصر معين للعمل عليه هو فقط دون 
باقي عناصر التنسيق .

يمكننا عمل عزل لشكل داخل Group عندما نختار أداة السهم الاسود
. Group و نضغط دبل كليك علي الـ 

نفتح ملف العمل Isolation mode الموجود في ملفات عمل المحاضرة الاولي 

 سنلاحظ أن كل الأشكال اصبحت أقل وضوحاً ماعدا الشكل الذي عزلناه
و نجد ايضاً شريط رمادي في اعلي الواجهة الرئيسية و هذا دليل 

علي أننا في حالة العزل.

• للخروج من الـ isolation mode نضغط دبل كليك في أي مكان أو نضغط من 	
) Esc ( لوحة المفاتيح علي زرار

 كلمة Fill معناها الملئ الداخلي للشكل 
و كلمة Stroke معناها حد خارجي حول الشكل 

تعتبر الـ Layers من أكثر مزايا برامج الجرافيسك فهي تسهل التعامل مع عناصر 
 التصميم مما يتيح لنا تنظيمها و القدرة علي اظهارها أو اخفائها أو حتي حماية

 الـ Layers من اجراء أي تعديل عليها .

نفتح ملف العمل Layers الموجود مع ملفات عمل المحاضرة الاولي 
• 	Layers Panel موجود في Layers كل مايخص الـWindow > Layers

Stroke و الـ Fill كل مايخص الـ Tools panel سنلاحظ في اسفل الـ

Fill

Fill

 Stroke و الـ Fill لون الـ 
) D ( أسود و ابيض

Stroke

Stroke و الـ Fill التحويل بين الـ

Stroke

solid color  
لون مصمت 

بدون تدريجات

Gradient 
تدريج لوني 

None 
لون شفاف

Panel menu
Taregt 

تنشيط عنصر من 
عناصر التصميم

هذا المربع معناه 
أن هذا العنصر من 
التصميم تم تحديده

Layer اظهار أو اخفاء

Layer إلغاء

 طبقة جديدة
New Layer

 طبقة فرعية جديدة
New Sub Layer

Layer قفل أو فك
مثلث فتح الـ Layers الفرعية

توضيح مكان Layer قمنا 
بتنشيطه من التصميم 

Clipping Mask

المحاضرة الأولي المحاضرة الأولي
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• لاعادة ترتيب الـ Layers نقوم بسحب 	
الـ Layer الي اعلي او الي اسفل 

• يمكننا ايضا ترتيب عناصر التصميم عن 	
طريق الأمر Arrange الموجود في 

Object قائمة 
أو اذا وقفنا كليك يمين علي اي عنصر 

في التصميم سنجد نفس الامر .

الوظيفةالأمر 

Bring to front أول شكل و يوكن وفق كل عناصر التصميم

Bring forward تحريك الشكل بمقدار  خطوة لاعلي

Send Backwardتحريك الشكل بمقدار  خطوة لاسفل

Send to Backاخر شكل و يوكن تحت كل عناصر التصميم

New Document فتح ملف عمل جديد

New الأمر File لفتح ملف عمل جديد نختار من قائمة 
 File > New ...... Ctrl + N

اسم  الملف

اعدادات اللوحة 
Artboard الفنية

المقاس

Bleed

قوالب تصميمة 
 جاهزة موجودة

اعدادات تناسب كل  مع البرنامج
أغراض التصميم

تأكيد  الغاء

Bleed معني كلمة

هي مسافة زائدة حول التصميم لتفادي مشاكل القص او التقطيع التي تحدث بعد 
 عملية الطباعة 

عادة توكن قيمة الـ Bleed من 2 الي 3 مليمتر 

توحيد قيم الـ Bleed من 
كل الاتجاهات

الـ Bleed هو المشار اليه 
بالخط الاحمر

المساحة الاصلية للتصميم

ناقش مع المحاضر الفائدة العملية من إضافة الـ Bleed إلي التصميم

المحاضرة الأولي المحاضرة الأولي
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للتعديل علي أي اعداد من إعدادات التصميم سواء في المقاس أو الـ Bleed أو 
 وحدة القياس المستخدمة في التصميم 

Document setup  الامر  File نختار من قائمة
 Control Panel الموجود في الـ Document Setup و سنجد أيضاً زر

Artboard اللوحة الفنية

Artboard سنلاحظ عند فتح ملف عمل جديد أن لدينا اختيار 
 و كلمة Artboard هي المساحة التي سيتم طباعتها .

و يمكننا فتح Artboard واحد و حتي Artboard 100 في الملف الواحد مما يسهل 
علينا تجميع أكثر من تصميم لشركة أو لمنتج أو لعميل في ملف واحد .

•  مثال :	
Artboard 4 سنفتح ملف عمل واحد به 

 New الامر File نختار من قائمة 
Artboard ستظهر لنا اعدادات الـ

• 	Atrboard Panel يمكننا أيضاً التعامل مع 
Window > Artboard

Art board عدد الـ

Art board  الـغاء

Art board  إعادة ترتيب الـ

 اتجاه
Art board الـ Art board المسافة بين الـ

Artboard جديدة

 طريقة ترتيب
Art board الـ 

 عدد الاعمدة
  التي نرتب بها

Art board الـ  

Artboard tool

 تعتبر أداة الـ Artboard tool و احدة من أهم أدوات برنامج الاليستريتور 
و هي المسئولة عن التعامل مع كل ما يخص الـ Artboard سواءاً مقاس أو عدد أو 

حتي أضافة أو الغاء أو إعادة ترتيب .

 Control Panel سنلاحظ تغير شكل الـ Artboard tool و بمجرد اختيار أداة الـ 
كما هو موضح أمامنا

المحاضرة الأولي المحاضرة الأولي
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 Artboard tool إذا اختارنا أداة الـ 
وضغطنا كليك علي أي Art board سنلاحظ  

 Artboard هذا الخط المتقطع حول الـ
مما يتيح لنا تحريكها أو تكبيرها و 

تصغيرها أو حتي الغاءها عند الضغط علي 
 Delete زر

Control Panel سنلاحظ اختيارين في غاية الاهمية في الـ

تحتوي الـ Control Panel علي اعدادات أخري هامة 

Artboard تحديد مساحة الـ X يميناً و يساراً مع المحور Artboard تحريك الـ 
أو لاعلي و اسفل مع المحور Y بقيمة محددة

Copy / Move 
يتيح لنا هذا الاختيار 

بتحريك أو نسخ 
الـ Artboard بما 
يحتويه من عناصر 

التصميم

 اسم 
Artboard الـ

اضافةالغاء

 وضعية
 Artboard الـ  

بالطول أو بالعرض

اعدادات مسبقة 
لمقاسات متعارف 

عليها

تابع مع المحاضر التطبيق العملي لتنفيذ 
مجموعة مطبوعات لشركة أو مؤسسة أو عميل .

Ruler & Guides

Ruler المسطرة

Guide خط الدليل

تستخدم المسطرة أو الـ Ruler في تحديد مساحة التصميم و تغيير وحدة القياس 
 ) Guides ( التي نعمل بها و تستخدم ايضاً في رسم خطوط الدليل

هي عبارة عن خطوط دليل وهمية لاتظهر في الطباعة تستخدم لتنظيم عناصر 
 التصميم .

 و يمكننا انشاء خط دليل Guide عندما نذهب الي المسطرة و نضغط عليها 
كليك و نسحب .

لتحريك خط الدليل Guide ماعلينا الا ان نختار أداة السهم الاسود و نضغط كليك 
 علي الـ Guide و نحركه 

Y أو X بمسافة محددة عن طريق ادخال قيم في خانة Guide و يمكننا تحريك الـ 
Control panel الموجودة في الـ

• 	 View لاظهار أو اخفاء المسطرة الي قائمة 
View > Rulers > Show rulers ... Ctrl + R

•  لتغيير وحدة القياس نقف كليك يمين	
 علي المسطرة و نختار وحدة القياس التي 

نريد العمل بها.

المحاضرة الأولي المحاضرة الأولي
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اذا وقفنا كليك يمن في اي مكان سيظهر لنا قائمة 
Guides فرعية بها كل الاوامر التي تخص الـ

و هو من أهم الأوامر المتعلقة بالـ Guides و هي عبارة عن خطوط دليل مؤقتة 
 تساعدنا علي تنسيق و ترتيب عناصر التصميم .

Smasrt Guide و نختار الامر View و لتفعيل هذا الأمر نذهب الي قائمة

 مثال : 
 عند تحريك الدائرة المشار اليها في الصورة 

نلاحظ دليل لونه اخضر يشير الي ان مركز هذة الدائرة 
التي نحركها علي نفس المحاذاة من مركز الدائرة 

 الاخري .

 ملحوظة :
 Distribution و الـ Align لن يغنينا هذا الامر عن أوامر الـ 

و التي سنناقشها بالتفصيل في المحاضرة الثالثة .

Smart Guide

 Zoom tool

 Hand tool

اختصار لوحة المفاتيح
keyboard shortcut  الأمر

Ctrl + (+) zoom in
Ctrl + (-) zoom out

Ctrl + (0) fit on screen 
view > fit Artboard on window

 تستخدم أداة الـ Zoom tool في التقريب أو البعد عن التصميم
و فيما يلي اهم اختصارات لوحة المفاتيح.

 تستخدم أداة الـ Hand tool للتنقل في مساحة الصورة 
و يجب أن نلاحظ أننا لا نحرك الصورة و انما نتنقل في مساحة الصورة .

عند الضغط علي المسطرة ) Space bar ( ننتقل من اي أداة 
نعمل بها الي أداة الـ Hand tool بشكل مؤقت . مهم جدا ..

Undo & Redo أوامر التراجع و التقدم

اختصار لوحة المفاتيح
keyboard shortcut  الأمر

Ctrl + (Z) Undo  
 تراجع لأكثر من خطوة

Ctrl + Shift + (Z) Redo 
تقدم لأكثر من خطوة

File > Revert 
F12

  إعادة التصميم لأصله
كما بدأنا العمل عليه

المحاضرة الأولي المحاضرة الأولي
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Basic Shapes أدوات رسم الأشكال الأساسية

هذه الأدوات هي اساس أي تصميم أو رسم أو لوجو حيث يعتمد الاليستريتور علي 
رسم أشكال هندسية و خطوط بسيطة يتم دمجها فيما بعد مع بعضها لنحصل 

علي شكل به تفاصيل أكثر .

هناك مجموعتان من أدوات رسم الأشكال الأساسية

Open Shapes
  الأشكال المفتوحة

( خطوط )
  الأشكال المغلقة

( أشكال هندسية )

Closed Shapes

تابع مع المحاضر الشرح المفصل لأدوات رسم الاشكال الاساسية

تابع مع المحاضر كيفية 
رسم الشكل الموضح 

بالصورة.

تدريب عملي تحت اشراف المحاضر

  المحاضرة الثانية 

المحاضرة الأولي

أهداف المحاضرة
•  Rotate & Reflect الدوران و الانعكاس	

Rotate كيفية عمل دوران لشكل 	 
Reflect كيفية عمل انعكاس لشكل 	

• 	Shape builder tool 
Shape builder tool ماهي أداة الـ 	 

Shapebuilder tool طريقة استخدام أداة الـ 	
• 	Width tool 

Width tool ماهي أداة الـ 	 
Width tool طريقة استخدام أداة الـ 	

• 	Free transform tool 
Free Transform  tool طريقة استخدام أداة الـ 	

• 	Save & Export حفظ الملفات 
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Rotate & Reflect الدوران و الانعكاس
Rotate كيفية عمل دوران لشكل

يمكننا عمل دوران Rotate لشكل في برنامج الاليستريتور باحدي طريقتين :

 الطريقة الأولي

مثال :

 الطريقة الثانية
Rotate tool 

نضغط علي الأداة دبل كليك 
Rotate فتظهر لما اعدادات الـ

 كليك يمين ثم نختار الامر التالي 
Transform > Rotate

Ellipse tool 1. نختار أداة الـ 
 2.نرسم شكل بيضاوي 

3. نختار لون Fill و Stroke مناسبين

4.نعمل Rotate باحدي الطريقتين 
 التي سبق ذكرهما

و نختار قيمة الدوران 30 درجة.

 ملحوظة هامة :
في برنامج الاليستريتور إذا كانت القيمة موجبة يوكن الدوران عسك اتجاه عقارب 

الساعة أما إذا كانت القيمة سالبة فيوكن الدوران مع اتجاه عقارب الساعة.

قيمة سالبة قيمة موجبة 

مع اتجاه عقارب الساعة عسك اتجاه عقارب الساعة

 لدينا اختياران في غاية الأهمية
Copy و الثاني Ok الأول 

ويوضح هذا الجدول الفرق بين كلا الأمرين 

إذا أردنا تكرار دوران الشكل بنفس الزاوية و نفس 
Object الاتجاه نختار الامر التالي من قائمة 

 Object > transform > transform again 

Ctrl + D

OK Copy

زاوية 30 زاوية 30

قمنا بدوران الشكل فقط بزاوية 30 
درجة دون عمل نسخة منه اصبح لدينا نسخة بزاوية 30 درجة

المحاضرة الثانية المحاضرة الثانية
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 سنلاحظ أن الدوران Rotate دائما يوكن من مركز الشكل 
 كيف يمكننا التحكم في مكان محور الدوران ؟؟

فيما يلي سيتضح لنا كيفية التحكم في مكان محور الدوران ..

Rotate tool دبل كليك علي الـRotate tool + Alt + كليك
في أي مكان

Rotate 1. تظهر لنا إعدادات الـ 
2. دائماً يوكن مركز الشكل هو 

محور الدوران

Rotate 1. تظهر لنا إعدادات الـ 
2. الميزة هنا أننا نستطيع التحكم 

في مكان محور الدوران.

Reflect كيفية عمل انعكاس لشكل

يمكننا استخدام الـ Opacity لعمل تداخل بين الاشكال

Rotate tool حاول ابتكار أشكال مختلفة باستخدام أداة الـ
تدريب عملي تحت اشراف المحاضر

يمكننا عمل دوران Rotate لشكل في برنامج الاليستريتور باحدي طريقتين :

 الطريقة الثانية الطريقة الأولي
Reflect tool 

نضغط علي الأداة دبل كليك 
Reflect فتظهر لما اعدادات الـ

 كليك يمين ثم نختار الامر التالي 
Transform > Reflect

المحاضرة الثانية المحاضرة الثانية
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Shape builder tool
Shape builder tool ماهي أداة الـ

Shapebuilder tool طريقة استخدام أداة الـ

هي أداة دمج و تلوين الأشكال.

 مثال رقم 1 :
1. نرسم دائرتين كما هو موضح بالشكل 

2. نحدد الدائرتين بأداة السهم الأسود

 Shapebuilder tool 3. نختار أداة الـ 
و بمجرد أن نقترب من مكان تقاطع الدائرتين نلاحظ 

هذا الظل الرمادي

5. نلاحظ أننا قمنا بتلوين التقاطع بين الدائرتين باللون الذي اختارناه

Shapebuilder tool 4. نضغط كليك بأدة الـ 
Control panel بعد اختيار لون مناسب من الـ

 مثال رقم 2 :
 1.نرسم أربعة دوائر كما هو موضح بالصورة 

و ذلك باتباع الخطوات التالية:

 2. نحدد الـ 4 دوائر بأداة السهم الاسود 
 Shape builder tool 3. نختار أداة الـ 

.Control panel 4. نحدد لون مناسب من الـ 

5. نضغط كليك و نسحب 
كما هو موضح بالصورة

6.يمكننا تلوين باكثر من 
لون و تحريك كل جزء تم 

تلوينه علي حدا باستخدام 
أداة السهم الاسود

1 2 3 4

نرسم دائرة  Alt نسحب مع 
لعمل نسخة 

من الدائرة

الشكل 
النهائي

 نحدد الدائرتين بأداة السهم الأسود 
 و نقوم بعمل Rotate بزاوية 90درجة

Copy و نختار

المحاضرة الثانية المحاضرة الثانية
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 ملحوظة هامة جداً :
 لا تعمل أداة الـ ShapeBuilder مع النصوص

Shape إالي شكل Text و إذا أردنا استخدامها مع النصوص يجب تحويل النص

 الخطوات :
 Type tool 1. نختار أداة الـ 

 2. نكتب حرف أو كلمة .
3. نختار أداة السهم الأسود .

Create outlines > 4. نقف كليك يمين علي و نختار الأمر

سيتحول الحرف إلي شكل و إذا الكلمة تتوكن من أكثر 
من حرف فإن هذه الحروف تتحول إالي Group و يجب 
فك الـ Group إذا أردنا التعامل مع كل حرف علي حدا

تستخدم أداة الـ ShapeBuilder tool لإلغاء أجزاء من الأشكال المتقاطعة

 مثال رقم 3 :
 في الشكل الذي رسمناه من قبل 

نريد إلغاء التقاطعات بين الدوائر .

1. بعد رسم الأربع دوائر نحددهم بأداة السهم الأسود 

الخلاصة

 Shapebuilder tool 2. نختار أداة الـ 
3. نضغط  Alt + كليك عند التقاطعات .

النتيجة الأمر 

Sh
ap

eb
ui

de
r t

oo
l

تلوين  كليك

تلوين + دمج  كليك + اسحب

إلغاء Alt + كليك

Width tool
Width tool ماهي أداة الـ

Width tool طريقة استخدام أداة الـ

مهمة هذه الأداة هي التحكم في تغيير سمك خط معين

 الخطوات :
 Shift و نرسم خط مستقيم مع استخدام الـ line sigment tool 1. نختار أداة الـ

لرسم خط رأسي .
 2. نحدد قيمة مناسبة للـ Stroke و الموجود في

pt 60  و ليكن Control panel الـ 

3. نختار أداة الـ width tool و من أي 
 مكان في الخط 

 نسحب يميناً لتكبير سمك الخط
أو نسحب يساراً لتصغير سمك الخط 

تابع مع المحاضر كيفية الاستفادة من أداة الـ Width tool و 
استخدامها مع أداة الـ Rotate tool في توكين اشكال متداخلة كما 

هو بالامثلة الموضحة

المحاضرة الثانية المحاضرة الثانية
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CC دبلومة الجرافيكساليستريتور 

ITC جميع حقوق الطبع و الملكية الفكرية محفوظة لشركة ITC أبراج الفالكون - عجمان -الامارات العربية المتحدةأبراج الفالكون - عجمان -الامارات العربية المتحدةجميع حقوق الطبع و الملكية الفكرية محفوظة لشركة

Free transform toolحفظ الملفات Save & Export
Transform يسأل الكثير من مستخدمي برنامج الاليستريتور أين توجد أوامر الـ

 الموجودة في برنامج الفوتوشوب ؟؟
 لدينا أداة الـ Free Transform tool و التي تقوم بهذه المهمة .

. CC و قد تم تحديث هذه الأداة بشكل رائع في الاصدار

 يمكننا حفظ الملفات من برنامج الاليستريتور علي هيئة ملفات عمل مفتوحة 
. Raster أو علي هيئة صور Vector

نذهب لقائمة File و نختار الأمر Save as لاختيار احد الامتدادات التالية :

 و فيما يلي سنشرح أهم هذه الامتدادات و هي  
Ai , Eps , Pdf , SVG

بمجرد اختيار أداة الـ Free transform toolتظهر لنا اعدادتها كالتالي :

تكبير و تصغير مع الحفاظ 
علي نسبة الطول و العرض

تكبير و تصغير بطريقة عادية 

 Prespective تكبير
و تصغير بشكل منظوري.

Distrot تكبير و تصغير 
بشكل حر و في اي اتجاه 

Free Transform  tool طريقة استخدام أداة الـ

Vector ملفات عمل مفتوحة .. Save

File قائمة

SaveExport

المحاضرة الثانية المحاضرة الثانية

Vector ملف آخر غير ملفات ملف عمل مفتوح 
الـ Vector صورة أو ملف أوتوكاد
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CC دبلومة الجرافيكساليستريتور 

ITC جميع حقوق الطبع و الملكية الفكرية محفوظة لشركة ITC أبراج الفالكون - عجمان -الامارات العربية المتحدةأبراج الفالكون - عجمان -الامارات العربية المتحدةجميع حقوق الطبع و الملكية الفكرية محفوظة لشركة

المحاضرة الثانية المحاضرة الثانية

Ai ملف عمل الاليستريتور

 Eps

SVG

Dialogue box يظهر هذا الـ Ai عند اختيار نوع الملف الـ

Dialogue box يظهر هذا الـ Pdf عند اختيار نوع الملف الـ

Encapsulated PostScript و هو اختصارا لكلمة

Scalable Vector Graphics و هو اختصارا لكلمة

الاختيار الاهم 
هو تحديد نسخة 
الاليستريتور التي 

تتوافق مع الملف 

 مثال :
CC لايمكن فتح ملف 

علي نسخة اليستريتور 
CS5 أو CS6 سابقة مثل

تحديد نسخة البرنامج 
الذي يتوافق مع الملف 

تسمح لنا هذة الاعدادات في ظبط علامات 
الطباعة لاعداد الملف لعملية فصل الالوان و 

يظهر لنا الناتج النهائي للملف كما هو موضح 
بالصورة

 ملف عمل مفتوح Vector مثل ملف الـ Ai تماماً 
 و الميزة الاساسية لملف الـ Eps أنه يفتح علي كل برامج الجرافيسك 

و يحل بعض مشاكل العمل خصوصاً إذا كنا نعمل علي برنامج 
 الاليستريتور و نريد تصدير ما قمنا بتصميمه 

الي برنامج الوكريل درو او غيرها من البرامج التي لا تقبل ملفات الاليستريتور

 ملف عمل مفتوح Vector مثل ملف الـ Ai تماماً 
و الميزة الاساسية لملف الـ SVG هو حجمه الصغير و أننا يمكننا استخدامه في 

المواقع مما يتيح لنا ظهور التصميمات بشكل حاد و ناعم دون بكسلة

 Pdf

Portable Document Format و هو اختصارا لكلمة
هو  ملف الـ Vector الأكثر شهرة و استخداماً سواءاً في الطباعة او 

الويب و لذلك لمزاياه الكبيرة كصغر حجمه و جودته و سهولة تداوله 
و قبول الكثير من ماكينات الطباعة له و امكانية اجراء عملية فصل 

الالوان منه .
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CC دبلومة الجرافيكساليستريتور 

ITC جميع حقوق الطبع و الملكية الفكرية محفوظة لشركة ITC أبراج الفالكون - عجمان -الامارات العربية المتحدةأبراج الفالكون - عجمان -الامارات العربية المتحدةجميع حقوق الطبع و الملكية الفكرية محفوظة لشركة

نذهب لقائمة File و نختار الأمر Export لاختيار احد الامتدادات التالية :

Vector ملفات عمل غير ملفات الـ .. Export

jpeg حفظ الملف علي هيئة صورة

File > Export 
jpeg و نختار الامتداد 

و هناك اختياران في غاية الأهمية يحدد كل منهما شكل الصورة النهائي.

 سيظهر هذا الـ Dialogue box و الذي يحتوي علي كل اعدادات الصورة
 و سنشرح اهمها

Color mode تحديد الـ

 تحديد جودة الصورة 
Resolution

تابع مع المحاضر كيفية 
رسم الشكل الموضح 

بالصورة.

تدريب عملي تحت اشراف المحاضر

المحاضرة الثانية المحاضرة الثانية
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CC دبلومة الجرافيكساليستريتور 

ITC جميع حقوق الطبع و الملكية الفكرية محفوظة لشركة ITC أبراج الفالكون - عجمان -الامارات العربية المتحدةأبراج الفالكون - عجمان -الامارات العربية المتحدةجميع حقوق الطبع و الملكية الفكرية محفوظة لشركة

  المحاضرة الثالثة 

أهداف المحاضرة
• 	Pathfinder Panel

كيف نرسم نصف دائرة ؟؟ 	 
تطبيق عملي  	

•  Align & Distribution المحاذاة و التوزيع 	
تطبيقات يتم تنفيذها 	

المحاضرة الثانية
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CC دبلومة الجرافيكساليستريتور 

ITC جميع حقوق الطبع و الملكية الفكرية محفوظة لشركة ITC أبراج الفالكون - عجمان -الامارات العربية المتحدةأبراج الفالكون - عجمان -الامارات العربية المتحدةجميع حقوق الطبع و الملكية الفكرية محفوظة لشركة

Pathfinder Panel
 Panel الموجودة في البرنامج ..فمن خلال هذه الـ Panels واحدة من أهم الـ

نقوم بعمل علاقات بين الأشكال مما يتيح لنا توكين عناصر جديدة من خلال دمج 
 أو قطع أو تقاطع الأشكال مع بعضها .

Window في قائمة Pathfinder Panel توجد الـ
نفتح ملف Pathfinder الموجود في ملفات عمل المحاضرة الثالثة.

و فيما يلي توضيح لكل أمر و نتيجته ..

Unite Exclude
Subtract Intersect

Divide

Divide

Trim

Trim

Merge

Merge

Crop

Crop

Outline

Outline

Minus Back

Minus Back

Unite

Exclude

Subtract

Intersect

Ungroup

المحاضرة الثالثة المحاضرة الثالثة
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CC دبلومة الجرافيكساليستريتور 

ITC جميع حقوق الطبع و الملكية الفكرية محفوظة لشركة ITC أبراج الفالكون - عجمان -الامارات العربية المتحدةأبراج الفالكون - عجمان -الامارات العربية المتحدةجميع حقوق الطبع و الملكية الفكرية محفوظة لشركة

كيف نرسم نصف دائرة ؟؟

تطبيق عملي :

+ +

ليس الغرض من هذا الجزء هو مجرد رسم نصف دائرة فقط و انما الغرض هو كيفية 
تقسيم أي شكل إلي جزءين أفقياً أو رأسياً .

 الخطوات :
1. نفتح ملف عمل جديد بمقاس مناسب ) 20 سنتيمتر طول * 20 سنتيمتر  عرض(

2. من قائمة File نختار الأمر Place لادخال صورة اللوجو CBC الموجودة في 
ملفات عمل المحاضرة الثالثة .

 3. نختار أداة الـ Ellipse tool و نرسم دائرة ) نضغط Shift لرسم دائرة ( .
4. نختار أداة الـ Eyedropper tool   لتلوين الدائرة بنفس لون اللوجو 

 5. ننسخ الدائرة التي رسمناها 
Alt نسحب بالسهم الأسود مع الضغط علي زرار

Ellipse tool 1. نرسم دائرة بأداة الـ 
 2. نرسم خطاً طولياً باستخدام أداة 

الـ Line segment tool في منتصف 
 الدائرة.

3. من الـ Pathfinder panel نختار 
Divide الأمر 

 4. نقف كليك يمين و نختار الأمر
 Ungroup لفك ارتباط نصفي الدائرة.

في هذا التطبيق سنشرح كيفية اعادة 
رسم هذا اللوجو مرة اخري علي برنامج 

الاليستريتور 

Ellipse tool 1. نرسم دائرة بأداة الـ 
 2. نرسم مستطيل باستخدام أداة 

Rectangle tool الـ 
3. نحدد الدائرة و المستطيل بأداة 

 السهم الأسود 
4.  من الـ Pathfinder panel نختار 

Minus front الأمر 

لدينا طريقتان

المحاضرة الثالثة المحاضرة الثالثة
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CC دبلومة الجرافيكساليستريتور 

ITC جميع حقوق الطبع و الملكية الفكرية محفوظة لشركة ITC أبراج الفالكون - عجمان -الامارات العربية المتحدةأبراج الفالكون - عجمان -الامارات العربية المتحدةجميع حقوق الطبع و الملكية الفكرية محفوظة لشركة

6. نقسم الدائرة التي نسخناها الي نصفين بإحدي 
 الطريقتين التي تم شرحهمها سابقاً

Divide و ليكن طريقة الـ

7.و بالتالي يوكن لدينا الشكل التالي .

8. نحدد بأداة السهم 
الأسود نصفي الدائرة لعمل 

دوران لهما بزاوية 90 درجة 
Copy و نختار

 11. نضع كل ربع دائرة في مكانه 
Smart guide و يفضل الاستدلال بالـ 

 كما هو موضح بالصورة.

12. نأخد نسخة من الدائرة لعمل الجزء المتبقي 

13. نضع هذه الاجزاء في مكانها .

14. نحصل علي الشكل النهائي 

9. نحصل علي الشكل التالي ..

10. ننسخ أي نصف دائرة لعمل ربع دائرة 

المحاضرة الثالثة المحاضرة الثالثة
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CC دبلومة الجرافيكساليستريتور 

ITC جميع حقوق الطبع و الملكية الفكرية محفوظة لشركة ITC أبراج الفالكون - عجمان -الامارات العربية المتحدةأبراج الفالكون - عجمان -الامارات العربية المتحدةجميع حقوق الطبع و الملكية الفكرية محفوظة لشركة

Align & Distribution 
المحاذاة و التوزيع

Align المحاذاة

Distribution التوزيع

 تستخدم المحاذاة لتنسيق عناصر التصميم مع بعضها 
 Align panel و كل مايخص المحاذاة و التوزيع موجود في 

Window الموجودة في قائمة

يستخدم هذا الامر لمساواة المسافات بين العناصر

Distribute Space يوجد هناك أمر في غاية الأهمية و هو 
 سنواجه مشكلة كبيرة في عملية التوزيع لاشكال ليس لها نفس الحجم

 كما في المثال التالي .. 

بعد تنفيذ أمر التوزيع نلاحظ عدم 
تساوي المسافات بين المربعات.

عند اختيار الامر Distribute Space نلاحظ تساوي المسافات بين الأشكال علي 
الرغم من اختلاف احجامها

لاظهار كل اعدادات المحاذاة و التوزيع 
Align panel الموجودة في الـ 

 نذهب الي القائمة الفرعية و نختار الامر 
 Show options كما هو موضح بالصورة

فتظهر لنا الـ Panel بهذا الشكل .

قبل البدء في عملية المحاذاة يجب أن نحدد 
أولا هل ستتم المحاذة للعناصر مع بعضها أم 
اننا نريد عمل محاذا لعناصر مع اللوحة الفنية 

Art board

محاذاة للعناصر مع بعضها

 محاذاة للعناصر مع 
Artboard الـ

المحاذاة بشكل رأسي

التوزيع بشكل رأسي

المحاذاة بشكل أفقي

التوزيع بشكل أفقي

المحاضرة الثالثة المحاضرة الثالثة
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CC دبلومة الجرافيكساليستريتور 

ITC جميع حقوق الطبع و الملكية الفكرية محفوظة لشركة ITC أبراج الفالكون - عجمان -الامارات العربية المتحدةأبراج الفالكون - عجمان -الامارات العربية المتحدةجميع حقوق الطبع و الملكية الفكرية محفوظة لشركة

  المحاضرة الرابعة 

أهداف المحاضرة
• التعامل مع الألوان 	

RGB طريقة 	
CMYK طريقة 	

•  مقدمة لابد منها	
Solide color 1. لون مصمت

Gradient 2. تدريج لوني
Pattern 3. التكرار

• 	Stroke
•  تطبيقات يتم تنفيذها	

تطبيقات يتم تنفيذها 

 تطبيق هذه الامثلة و تنفيذها 
يوضح مدي الاستفادة من الاوامر التي 

تم شرحها  في المحاضرات السابقة 

المحاضرة الثالثة
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CC دبلومة الجرافيكساليستريتور 

ITC جميع حقوق الطبع و الملكية الفكرية محفوظة لشركة ITC أبراج الفالكون - عجمان -الامارات العربية المتحدةأبراج الفالكون - عجمان -الامارات العربية المتحدةجميع حقوق الطبع و الملكية الفكرية محفوظة لشركة

التعامل مع الألوان
قبل البدء في شرح كيفية التعامل مع الألوان في برنامج الاليستريتور يجب أن 

نعرف أن لدينا طريقتان لتوكين الألوان و هما الأكثر أهمية و استخداماً في عالم 
الجرافيسك .

 نستطيع اختيار لون من إحدي مكانين
Swatches panel أو من Color panel إما من 

Color نختار Window من قائمة 
Show Options لاظهار طريقة التلوين نختار من القائمة الفرعية

و منها نستطيع اختيار اللون الذي نريده

RGB طريقة

مقدمة لابد منها

CMYK طريقة

Solide color 1. لون مصمت

Color Panel

Swatches Panel

 هي طريقة توكين ألوان الضوء
 R =red أحمر 

 G =green أخضر 
 B =blue أزرق 

بمعني أننا إذا أردنا التعامل مع تصميم 
سيظهر علي شاشة كمبيوتر أو موبايل 

 RGB نستخدم طريق الـ 

 هي طريقة توكين ألوان أحبار الطباعة
 C =cyan سماوي  

 M =magenta قرمزي 
 Y =yellow أصفر  
 K =black أسود  

بمعني أننا إذا أردنا التعامل مع تصميم ستتم 
CMYK طباعته فإننا نستخدم طريقة

نستطيع اختيار و تحديد اللون في برنامج الاليستريتور بعدة طرق لكننا سنجمل 
طرق التلوين في البرنامج في 3 طرق

و سنشرح كل طريقة بشكل مفصل .

Solid color .1 
لون مصمت

Gradient.2 
تدريج لوني 

Pattern.3 
تكرار

Swatches نختار Window من قائمة

تغيير طريقة رؤية الالوان

الغاء

Swatch اضافة

 مجموعة لونية 
color group

تحديد نوع الألوان 
 التي نراها في

Panel الـ 

 المكتبات اللونية 
Color libraries

kuler

 swatches
options

المحاضرة الرابعة المحاضرة الرابعة
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CC دبلومة الجرافيكساليستريتور 

ITC جميع حقوق الطبع و الملكية الفكرية محفوظة لشركة ITC أبراج الفالكون - عجمان -الامارات العربية المتحدةأبراج الفالكون - عجمان -الامارات العربية المتحدةجميع حقوق الطبع و الملكية الفكرية محفوظة لشركة

Swatches options من الـ Swatch يمكننا تعديل الـ 
swatch و التي نظهرها عندما نضغط دبل كليك علي أي 

Swatches panel او من ايوكنة  الموجود في اسفل الـ

يوجد اختيار هام جدا في الـ Swatches و هو المكتبات اللونية الموجودة مع 
 Libraries البرنامج 

 و تظهر هذه المكتبات عندما نضغط علي ايوكنة 
Swatches الموجودة أسفل الـ 

Global 
إذا قمنا بالتعديل علي 

أي Swatchسيظهر هذا 
التعديل في كل الاشكال 

 المستخدم فيها هذا 
Swatch الـ

 القيم اللونية
Swatch للـ 

سيظهر لنا العديد من 
المجموعات اللونية 

يمكننا التقليب بين هذه 
المجموعات بالسهمين 

المشار اليهما في الصورة

 Gradient 2. تدريج لوني

 Gradient معناها تدريج لوني و يتم تطبيق الـ Gradient كلمة 
 Stroke او الـ Fill سواءاً علي الـ 

 Gradient هذا التخطيط يوضح طريقة تطبيق الـ

 ملحوظة هامة جداً جداً :
أداة الـ Gradient لاتقوم بتطبيق 
الـ Gradient كما هو الحال في 

الفوتوشوب و انما مهمتها التعديل 
علي شكل مطبق عليه Gradient بالفعل

 الخطوة الأولي 
Gradient تطبيق الـ

 الخطوة الثانية
Gradient تعديل الـ

Window > Gradient

 1. نرسم أي شكل 
 2. نضغط كليك علي 

Gradient شكل الـ

Gradi�  عند اختيار أداة الـ 
ent tool سيظهر لنا شريط 

Gradient تعديل الـ

Linear 
خطي 

Linear 
خطي 

Radial 
دائري 

تحريك الـ Gradientتكبير أو تصغير أو دوران

Radial 
دائري 

المحاضرة الرابعة المحاضرة الرابعة
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CC دبلومة الجرافيكساليستريتور 

ITC جميع حقوق الطبع و الملكية الفكرية محفوظة لشركة ITC أبراج الفالكون - عجمان -الامارات العربية المتحدةأبراج الفالكون - عجمان -الامارات العربية المتحدةجميع حقوق الطبع و الملكية الفكرية محفوظة لشركة

Gradient تعديل الـ

Stroke علي الـ Gradient تطبيق الـ
Stroke علي Gradient يمكننا تطبيق الـ 

 Stroke لكن علينا أن نتأكد من اننا قمنا بتنشيط الـ 
كما هو مشار اليه في الصورة

 Gradient و نطبق عليه الـ Spiral tool نرسم خطاً باستخدام 
بالطرق الثلاثة الموجودة .

Color stop اذا ضغطنا دبل كليك علي الـ 
 Color panel سيظهر لنا إما الـ 

أو الـ swatches panel و نختار منهما اللون 
المناسب 

Color stop

Pattern 3. التكرار

الـ Pattern هو شكل أو كلمة تستخدم كتكرار لملئ شكل معين به 
 Pattern نموذجين من الـ Swatches Panel و يوجد في الـ

كما توجد في المكتبة 
مجموعات Pattern موجودة 

مع البرنامج .

المحاضرة الرابعة المحاضرة الرابعة



57

CC اليستريتور  دبلومة الجرافيكس

56

CC دبلومة الجرافيكساليستريتور 

ITC جميع حقوق الطبع و الملكية الفكرية محفوظة لشركة ITC أبراج الفالكون - عجمان -الامارات العربية المتحدةأبراج الفالكون - عجمان -الامارات العربية المتحدةجميع حقوق الطبع و الملكية الفكرية محفوظة لشركة

Pattern تعديل الـ
 يمكننا تعديل الـ Pattern من قائمة 

Object >Pattern > Edit Pattern

Pattern options تابع مع المحاضر كيفية التعامل مع الـ

Pattern كيفية عملStroke

1. نرسم أي شكل و نحددة باداة السهم الأسود

 Swatches panel 2. نسحب شكل النجمة الي الـ
 Pattern لتحويل هذا الشكل الي 

 أو نذهب الي قائمة 
Object > Pattren > make

 كل مايخص الـ Stroke موجود في
Stroke Panel الـ 

 لاظهار كل الاعدادات
 نختار من القائمة الفرعية 

Show Options

بهذا تظهر لنا كل الاعدادات

 سمك الخط

شكل نهايات الخط

Path بالنسبة للـ Stroke مكان الـ

خط متقطع

إعدادات الخط المتقطع

شكل الـ Stroke عند الأركان

Dash DashGap

ضبط الاركان 
مع الخط 
المتقطع

المحاضرة الرابعة المحاضرة الرابعة
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CC دبلومة الجرافيكساليستريتور 

ITC جميع حقوق الطبع و الملكية الفكرية محفوظة لشركة ITC أبراج الفالكون - عجمان -الامارات العربية المتحدةأبراج الفالكون - عجمان -الامارات العربية المتحدةجميع حقوق الطبع و الملكية الفكرية محفوظة لشركة

 يمكننا اضافة 
رؤوس اسهم الي 

 نهايات الخطوط 
كما هو موضح 

بالصورة

Profile من خلال الـ Stroke كما يمكننا التحكم في شكل الـ

Appearance Panel

تطبيقات يتم تنفيذها 

كلمة Appearance معناها الشكل النهائي 
للـ Path و مايحمله من Fill أو Stroke أو 

Effect

 مواصفات أي شكل موجودة في 
Appearance Panel و الموجودة في قائمة 

Window

المحاضرة الرابعة المحاضرة الرابعة
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CC دبلومة الجرافيكساليستريتور 

ITC جميع حقوق الطبع و الملكية الفكرية محفوظة لشركة ITC أبراج الفالكون - عجمان -الامارات العربية المتحدةأبراج الفالكون - عجمان -الامارات العربية المتحدةجميع حقوق الطبع و الملكية الفكرية محفوظة لشركة

  المحاضرة الخامسة 

أهداف المحاضرة
• 	Pentool أداة الـ 

Pen tool تعريف الـ 
ماهو الـ Path ؟

• 	Pen tool طريقة استخدام  الـ
• تطبيق عملي 	
• أدوات التقطيع	

Eraser tool 	
scissors tool 	 

 knife tool 	
• 	Paths عند التعامل مع الـ control panel شكل الـ

المحاضرة الرابعة
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CC دبلومة الجرافيكساليستريتور 

ITC جميع حقوق الطبع و الملكية الفكرية محفوظة لشركة ITC أبراج الفالكون - عجمان -الامارات العربية المتحدةأبراج الفالكون - عجمان -الامارات العربية المتحدةجميع حقوق الطبع و الملكية الفكرية محفوظة لشركة

المحاضرة الخامسة المحاضرة الخامسة

Pen tool طريقة استخدام  الـ

Path توكين الـ

Path لرسم الـ pen tool هناك قاعدتان في استخدام الـ

+

+

+

+

كليك

كليك و أسحب

خط مستقيم
straight line

  خط منحني
Curved line

نقطة حادة
Corner anchor point

نقطة ناعمة
Smooth anchor point

 القاعدة الأولي

 القاعدة الثانية

 كما نري في هذا الشكل 
 أن الـ Path يتوكن من ثلاثة أجزاء 

 Path جسم الـ 
Anachor point 

 Handle ذراع تحكم

 Handle كلما زاد طول الـ 
Path زاد انحناء الـ

Pentool
Pen tool تعريف الـ

الـ Pen tool و أخواتها ..

ماهو الـ Path ؟

 Path هي أداة رسم الـ pen tool الـ

الـ Path عبارة عن خطوط مستقسمة أو منحنية مرتبطة ببعضها عن طريق نقط 
Anchor points  تحكم تسمي

Path أداة رسم الـ

Path الادوات التي تتعامل مع الـ

Anchor point إضافة نقطة تحكم
Anchor point إلغاء نقطة تحكم

أداة تحويل نقطة حادة الي ناعمة و العسك

بمجرد استخدام أداة الـ Pen tool في الرسم تتحول الـ Control panel الي 
هذا الشكل و التي تساعدنا في التحكم في الـ Path بشكل أكثر دقة
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CC دبلومة الجرافيكساليستريتور 

ITC جميع حقوق الطبع و الملكية الفكرية محفوظة لشركة ITC أبراج الفالكون - عجمان -الامارات العربية المتحدةأبراج الفالكون - عجمان -الامارات العربية المتحدةجميع حقوق الطبع و الملكية الفكرية محفوظة لشركة

نبدأ برسم الخطوط السوداء باستخدام أدة الـ Pen tool بسمك مناسبتطبيق عملي 

 بعد الانتهاء من رسم الخطوط
 نحول هذة الخطوط الي اشكال 

Object > path > outline stroke 
 حتي نستطيع التلوين بأداة

Shape builder tool الـ 

يجب أن نراعي عند العمل بأداة الـ Pen tool كيفية التحويل 
 Corner Anchor point و الـ Smooth anchor بين الـ

 الخطوات :
A4 1. نفتح ملف عمل جديد بمقاس 

sonic sketch 2. ندخل الصورة
الموجودة في ملفات عمل المحاضرة 

 الخامسة
File > place

 Layer  نحول Layers panel 3. من الـ
 Template الصورة الي 

و المقصود بـ Template هو لاير 
مقفول حتي لايتحرك أثناء الرسم و 

 الصورة التي بداخله ستوكن
Opacity 50% بـ 

4. لتحويل اللاير الي Template نضغط 
دبل كليك علي اللاير المشار اليه في 

Template الصورة و ننشط الاختيار

 5. يجب أن نراعي أننا نرسم بـ Stroke فقط
 None يوكن شفاف أو Fill و الـ 

6. نفتح لاير جديد للرسم فيه حتي نفصل 
مانرسمه عن الصورة الاصلية.

المحاضرة الخامسة المحاضرة الخامسة

pen tool + Alt

Pen tool تابع مع المحاضر بشكل مفصل كيفية استخدام الـ

تطبيقات يتم تنفيذها 

صورة Kitty موجودة في 
ملفات عمل المحاضرة الخامسة

في هذا التطبيق سنعيد رسم صورة Sonic و المرسومة بالقلم الرصاص .



67

CC اليستريتور  دبلومة الجرافيكس

66

CC دبلومة الجرافيكساليستريتور 

ITC جميع حقوق الطبع و الملكية الفكرية محفوظة لشركة ITC أبراج الفالكون - عجمان -الامارات العربية المتحدةأبراج الفالكون - عجمان -الامارات العربية المتحدةجميع حقوق الطبع و الملكية الفكرية محفوظة لشركة

أدوات التقطيع

Eraser tool

 تستخدم هذه الأداة لتقطيع الاشكال 
 ويمكن التحكم في مقاس الاداة باستخدام اختصار لوحة المفاتيح

) د ( لتكبير حجم الاداة و ) ج ( لتصغير حجم الاداة

 تستخدم هذه الاداة في تقسيم الشكل الي قطاعات 
 وهي في الاساس تقطع الشكل علي هيئة خطوط منحنية 

Alt و يمكننا التقطيع علي هيئة خطوط مستقيمة مع الضعط علي

 يمكننا ايضا استخدام هذه الادوات مع النصوص 
 بشرط تحويل النص الي شكل 

Create outlines كليك يمن علي الكتابة و نختار الامر

 لتحريك كل جزء تم تقطيعه نختار أداة السهم الاسود و نفك الـ Group اولًا
Ungroup > كليك يمين 

ثم نحرك كل جزء علي حدا.

Scissors tool

Knife tool

 تستخدم هذة الأداة لتقسيم الـ Path الي أجزاء 
فبمجرد ان نضغط كليك في اي مكان علي الـ path فاننا نقطع من هذة النقطة.

Alt

المحاضرة الخامسة المحاضرة الخامسة
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CC دبلومة الجرافيكساليستريتور 

ITC جميع حقوق الطبع و الملكية الفكرية محفوظة لشركة ITC أبراج الفالكون - عجمان -الامارات العربية المتحدةأبراج الفالكون - عجمان -الامارات العربية المتحدةجميع حقوق الطبع و الملكية الفكرية محفوظة لشركة

 ملحوظة هامة جدا جدا 
 CC 2014 في الاصدار 

 عند تحديد نقطة Anchor point بالسهم الابيض تظهر لنا هذه النقطة 
و التي يمكننا التحكم في مدي استدارة هذه النقطة

 و سنجد كل مايخص هذا الشكل 
Transform panel موجود في الـ 
Window و الموجودة في قائمة

 Smooth Anchor point التحويل من 
Corner Anchor point إلي

 Corner Anchor point التحويل من 
Smooth Anchor point إلي

اظهار أو اخفاء أذرع التحكم

Anchor point الغاء
ربط نقطتين ببعضهما

قطع الـ Path من عند 
هذه النقطة

المحاضرة الخامسة

  المحاضرة السادسة 

أهداف المحاضرة
• 	Type tool
• 	Area Type tool
• 	Type on path tool
• 	Touch Type tool
• تحديد نوع الفونت المستخدم في الكتابة	
• 	Character Panel
• 	Paragraph Panel
• 	Clipping mask
• تطبيقات يتم تنفيذها	

 Anchor point أو تحديد نقطة Pen tool عند استخدام الـ 
فإن شكل الـ Control panel يتغير للشكل الذي نراه ليتيح لنا امكانية أكبر للتحكم 

Path في الـ
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CC دبلومة الجرافيكساليستريتور 

ITC جميع حقوق الطبع و الملكية الفكرية محفوظة لشركة ITC أبراج الفالكون - عجمان -الامارات العربية المتحدةأبراج الفالكون - عجمان -الامارات العربية المتحدةجميع حقوق الطبع و الملكية الفكرية محفوظة لشركة

Type

Type tool AreaType tool Type on a path tool Touch Type tool

Text يوجد طريقتان لادخال النص أو الـ
و هي أداة الكتابة العادية.

Paragraph Type Point Type
Type tool 1. نختار أداة الـ 

2.نضغط كليك لبدء الكتابة .
Type tool 1. نختار أداة الـ 

2.نضغط كليك و نسحب لعمل 
مساحة كتابة .

 Type tool

Paragraph Type و Point Type نضغط دبل كليك للتحويل بين

ناقش مع المحاضر الفرق بين كلا النوعين في الكتابة.

Area Type tool

Type on path tool

Path وظيفة هذه الأداة هي الكتابة داخل 
 1. نختار أداة الـ Ellipse tool و نرسم دائرة

 Area Type tool 2. نختار أداة الـ 
pathسنلاحظ ظهور علامة الكتابة داخل الـ Path 3. نضغط كليك علي الـ 

Path و بذلك ستوكن أي كتابة داخل الـ

1 2 3

Path وظيفة هذه الأداة هي الكتابة علي 
 1. نختار أداة الـ pen tool و نرسم خطاً .
 Type on a path tool 2. نختار أداة الـ 

pathسنلاحظ ظهور علامة الكتابة علي الـ Path 3. نضغط كليك علي الـ

1 2
لتغيير اتجاه الكتابة علي الـ path نختار أداة السهم الاسود و نسحب 

علامة       لأعلي أو لأسفل كما هو موضح بالصورة.

المحاضرة السادسة المحاضرة السادسة
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CC دبلومة الجرافيكساليستريتور 

ITC جميع حقوق الطبع و الملكية الفكرية محفوظة لشركة ITC أبراج الفالكون - عجمان -الامارات العربية المتحدةأبراج الفالكون - عجمان -الامارات العربية المتحدةجميع حقوق الطبع و الملكية الفكرية محفوظة لشركة

Touch Type tool

 وظيفة هذه الأداة هي التعديل علي حرف واحد في الكلمة بشكل منفصل 
بتحريكه لاعلي أو لأسفل أو دورانه أو تكبيره و تصغيره .

تحديد نوع الفونت المستخدم في الكتابة 

دوران

تكبير و تصغير 
بشكل طولي 

تكبير و تصغير 
بشكل عرضي 

تكبير و تصغير 
مع الحفاظ علي 

نسبة الطول و 
العرض 

تحريك

 من الملفت للنظر في برنامج الاليستريتور أننا عندما نكتب نصاً و نذهب إلي 
الـ Control panel لنختار نوع الفونت لانري شكل الفونت إنما نري اسم الفونت 

 فقط لاغير ...
 و لحل هذه المشكلة ..

. Font بعد الكتابة نقف كليك يمين علي الكتابة و نختار

Character Panel

1

6

2

7

3

8
4 9
5

10

إعدادات الكتابة العربية

اختصار لوحة المفاتيح الوظيفة الامر الرقم

- اختيار نوع الخط Font Family 1
 Bold - italic التنقل بين انماط الخط 

Font style و غيرها 2

Ctrl + Shift + ز
تكبير حجم الفونت
Ctrl + Shift + و

تصغير حجم الفونت

اختيار حجم الخط Font size 3

Alt +    . التحكم في المسافة بين حرفين اثنين فقط Kerning 4

- اختيار النسبة المئوية لتكبير الخط رأسياً Vertical scale 5

-  ظبط المسافة لارتفاع او نزل الحرف او
الكلمة عن السطر Baseline shift 6

- زاوية دوران الحرف Character rotating 7

- اختيار النسبة المئوية لتكبير الخط أفقياً Horizontal scale 8

Alt +    .  التحكم في المسافة بين الحروف في النص
الذي تم تحديده Tracking 9

Alt +    . التحكم في المسافة بين السطور Leading 10

المحاضرة السادسة المحاضرة السادسة
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CC دبلومة الجرافيكساليستريتور 

ITC جميع حقوق الطبع و الملكية الفكرية محفوظة لشركة ITC أبراج الفالكون - عجمان -الامارات العربية المتحدةأبراج الفالكون - عجمان -الامارات العربية المتحدةجميع حقوق الطبع و الملكية الفكرية محفوظة لشركة

Paragraph PanelClipping mask

Clipping mask توكين الـ

Clipping mask كيفية عمل  الـ

1
2
3

7

84
95

6

الوظيفة الامر الرقم

تمثل رموز ضبط محاذاة النصوص Alignment and justification 1

 تحدد المسافة بين الكتابة و الحد الايسر
من مساحة الكتابة Left indent 2

تحديد المسافة التي سيبدأ بعدها اول 
Paragraph سطر في الـ First line indent 3

Paragraph تحديد المسافة قبل الـ Add space before Paragragh 4

 تحديد اتجاه الكتابة من اليمين الي الشمال
 أو العسك و هو اختيار مهم جدا في

كتابة اللغة العربية
Text Direction 5

 هو الامر المسئول عن تكملة الكلمة في
 السطر التالي اذا كانت الكلمة اكبر من

المافة المتبقية في السطر
Hyphenate 6

 تحدد المسافة بين الكتابة و الحد الايمن
من مساحة الكتابة Right indent 7

Paragraph تحديد المسافة قبل الـ Add space after Paragragh 8

هو الامر المسئول عن مد الحرف
  محمــــــــــــــــــــــــــد

Shift + j (ت)
Kashida 9

معني كلمة Clipping mask هو رسم شكل داخل شكل من خلال الـ paragraph panel نستطيع التحكم في كل تنسيقات الفقرات

Content 
 هي الأشكال التي بالداخل

Clipping mask لدينا طريقتان لعمل الـ

Clipping Path 
هو الشكل الخارجي

 ملحوظة هامة جداً :
..Clipping mask يجي مراعاة شرطين في غاية الأهمية قبل عمل الـ 

Clipping Path أو الـ Content  أولا : يجب تحديد كل الأشكال سواءاً الـ 
         بأداة السهم الأسود.

ثانياً : يجب ان يوكن الـ Clipping Path هو أعلي شكل 

Make clipping mask > كليك يمينObject > Clipping mask > make

المحاضرة السادسة المحاضرة السادسة
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CC دبلومة الجرافيكساليستريتور 

ITC جميع حقوق الطبع و الملكية الفكرية محفوظة لشركة ITC أبراج الفالكون - عجمان -الامارات العربية المتحدةأبراج الفالكون - عجمان -الامارات العربية المتحدةجميع حقوق الطبع و الملكية الفكرية محفوظة لشركة

تطبيقات يتم تنفيذها 

الصورة موجودة في ملفات 
عمل المحاضرة السادسة

الصورة موجودة في ملفات 
عمل المحاضرة السادسة

  المحاضرة السابعة 

أهداف المحاضرة
• 	Brushes الفرش
• 	Calligraphic Brush .1 	 

Art Brush.2 	 
Scatter Brush .3 	 
Pattern Brush .4 	 
Bristtle Brush .5 	

• 	Pencil tool 
• 	Blend 

المحاضرة السادسة
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CC دبلومة الجرافيكساليستريتور 

ITC جميع حقوق الطبع و الملكية الفكرية محفوظة لشركة ITC أبراج الفالكون - عجمان -الامارات العربية المتحدةأبراج الفالكون - عجمان -الامارات العربية المتحدةجميع حقوق الطبع و الملكية الفكرية محفوظة لشركة

المحاضرة السابعة المحاضرة السابعة

Brushes الفرش
تعتمد كفرة الـ Brushes في الاليستريتور علي الـ Path و ليس مجرد شكل أو 

بكسلات نرسمه في لاير كما في الفوتوشوب 

 Brushes لدينا خمسة أنواع للـ

brushes لدينا أداتين للـ

Paint brush toolBlob brush tool

 Pattern
Brush

 Bristtle
Brush

Scatter Brush Art Brush  Calligraphic
Brush

كل مايخص الـ Brushes  موجود في الـ Brushes Panel و الموجودة في قائمة 
Window

و فيما يلي سنشرح كل أنواع الـ Brushes و كيفية التعامل معها

Calligraphic Brush .1

Art Brush.2

 و هو الشكل الأساسي للـ Brushes و توجد الـ Calligraphic Brush في أعلي 
Brushes Panel الـ

 تعتمد كفرة هذا النوع علي مد شكل معين علي الـ Path من أوله إلي آخره
و توجد الـ Art Brush في الـ Brushes panel  علي هيئة شريط عريض كما هو 

موضح بالصورة .

للتعديل علي الـ Brush نضغط دبل كليك 
علي شكلها فتظهر إعداداتها.

للتعديل علي الـ Brush نضغط دبل 
كليك علي شكلها فتظهر إعداداتها.
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CC دبلومة الجرافيكساليستريتور 

ITC جميع حقوق الطبع و الملكية الفكرية محفوظة لشركة ITC أبراج الفالكون - عجمان -الامارات العربية المتحدةأبراج الفالكون - عجمان -الامارات العربية المتحدةجميع حقوق الطبع و الملكية الفكرية محفوظة لشركة

يوجد في المكتبة مجموعات برشات جاهزة

 يمكننا تحميل برشات من الانترنت
Brushes for Illustrator عندما نبحث عن كلمة 

سنجد العديد من المواقع التي نستطيع تحميل برشات 
 منها.

عندما نختار الامر Other library نستطيع ادخال 
البرشات التي قمنا بتحميلها

 يمكننا أيضاً أن نوكن Art brush من شكل معين .
 الخطوات : 

 1. نرسم شكل بيضاوي 
2. نختار أداة الـ Convert anchor point tool و نحول النقطتين المشار اليهما 

في الصورة إلي Corner anchor point ) كليك علي النقطة ( .

3. لتحويل هذا الشكل إلي Brush نختار أداة السهم الأسود و نسحب الشكل إلي 
Brushes Panel الـ

 Dialogue box 4. سيظهر لنا هذا الـ
Art brush و نختار

Art brush 5. و سيظهر لنا اعدادات الـ

Brush اتجاه الـ

Brush اتجاه الـ

 مقاس
Brush الـ 

Brush اسم الـ

المحاضرة السابعة المحاضرة السابعة
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CC دبلومة الجرافيكساليستريتور 

ITC جميع حقوق الطبع و الملكية الفكرية محفوظة لشركة ITC أبراج الفالكون - عجمان -الامارات العربية المتحدةأبراج الفالكون - عجمان -الامارات العربية المتحدةجميع حقوق الطبع و الملكية الفكرية محفوظة لشركة

Paint brush tool 6. نختار أداة الـ 
 و نرسم بالشكل الذي قمنا بتوكينه

Scatter Brush .3

Path علي توزيع شكل علي امتداد الـ Scatter brush تعتمد كفرة الـ

 Path علي تكرار وحدات معينة علي مدي الـ Pattern brush تعتمد كفرة الـ 
و توجد الـ Pattern brush علي هيئة شريط متقطع كما في الصورة .

توجد الـ Scatter brush علي هيئة مربع 
تحت الـ Calligraphy brush كما هو 

موضح بالصورة .
كل اعدادات الـ Scatter brush تظهر 

عندما نضغط دبل كليك علي شكل البرش

تابع مع المحاضر 
 كيفية التعامل 

 Scatter brush مع الـ
و اعداداتها

Pattern Brush .4

 و تتوكن من خمسة أجزاء .
 Tile .1 

Inner Corner .2 
Outer Corner .3 

Start tile .4 
End tile .5

كل اعدادات الـ Pattern brush تظهر عندما نضغط دبل كليك علي شكل البرش

1

2

3 5

4 يمكننا تحميل برشات من 
 الانترنت

عندما نبحث عن كلمة 
Brushes for Illustrator 
سنجد العديد من المواقع 

 التي نستطيع تحميل برشات منها.
عندما نختار الامر Other library نستطيع ادخال البرشات التي قمنا بتحميلها

المحاضرة السابعة المحاضرة السابعة
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CC دبلومة الجرافيكساليستريتور 

ITC جميع حقوق الطبع و الملكية الفكرية محفوظة لشركة ITC أبراج الفالكون - عجمان -الامارات العربية المتحدةأبراج الفالكون - عجمان -الامارات العربية المتحدةجميع حقوق الطبع و الملكية الفكرية محفوظة لشركة

 من الأضافات الهامة في الأصدار CC أننا يمكننا تحويل 
. Pattern brush الصور الي

Pattern brush تابع مع المحاضر كيفية تحويل الصورة الي

Bristtle Brush .5

هذا النوع من الـ Brushes يحاكي شكل البرشات التي تستخدم في الرسم .

 Bristtle كل اعدادات و أشكال الـ
 brush 

تظهر عندما نضغط دبل كليك 
علي شكل البرش

Pencil tool
 Brush هي أداة رسم مثلها مثل الـ 

 لكن الفرق هنا أن الـ Pencil ترسم خطاً أساسياً Basic line لايوجد عليه أي تأثير
Pencil tool و كل اعدادات الأداة تظهر عندما نضغط دبل كليك علي الـ

 Pencil tool نلاحظ الفرق بين نتيجة استخدام الـ Fidelity إذا قمنا بتغيير قيمة الـ
Accurate أو Smooth عندما يوكن المؤشر عند

هذه الاعدادات موجودة في الاصدار CC 2014 و ليست في اي اصدار سابق

الاعداد الاكثر اهمية 
و الذي من خلاله 
نتحكم في مدي 

Path نعومة الـ

المحاضرة السابعة المحاضرة السابعة
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CC دبلومة الجرافيكساليستريتور 
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Blend
Blend معني كلمة

 Blend طريقة عمل الـ

Blend tool الطريقة الأولي

هو عمل انتقال بين شكل و شكل أو بين لون و لون .

Blend باستخدام أداة الـObject > Blend > Make

Blend لدينا طريقتان لعمل الـ

الطريقة الثانية الطريقة الأولي 

 1. نرسم شكلين كما هو موضح بالصورة.
2. نختار أداة الـ Blend   و نضغط 

كليك علي شكل السداسي أولا ثم علي 
شكل النجمة

3. توكن النتيجة كالتالي .

Object > Blend > Make  الطريقة الثانية

Blend التعديل علي الـ

1. نرسم شكلين كما بالصورة .
 2. نحدد الشكلين بأداة السهم الاسود 

 3. من قائمة Object نختار ..
Object > Blend > Make

4. توكن النتيجة كالتالي 

 Blend tool نضغط دبل كليك علي أدة الـ Blend للتعديل علي الـ 
 أو من قائمة Object نختار ..

Object > Blend > Blend options

هذه الاختيارات هي التي تحدد 
طريقة الانتقال بين الاشكال

المحاضرة السابعة المحاضرة السابعة
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CC دبلومة الجرافيكساليستريتور 
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انتقال بشكل تدريجي

 ملحوظة : 
لا يشترط أن يوكن اتجاه الـ Blend دائماً في خط مستقيم و أنما يمكننا تطبيقه 

Path علي أي شكل

 الخطوات : 
1. نقوم بعمل Blend بين الدائرتين الموضحتان بالصورة 

 Blend Options من اعدادات الـ Blend 2. نعدل الـ
كما هو موضح بالصورة .

3. نرسم بأداة Spiral tool شكل حلزوني .

4. نحدد كل الأشكال باداة السهم الاسود 
.. Object و نختار من قائمة 

Object > Blend > Replace spine

انتقال بعدد خطوات محدد

انتقال بمسافات محددة بين الاشكال

المحاضرة السابعة المحاضرة السابعة
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CC دبلومة الجرافيكساليستريتور 

ITC جميع حقوق الطبع و الملكية الفكرية محفوظة لشركة ITC أبراج الفالكون - عجمان -الامارات العربية المتحدةأبراج الفالكون - عجمان -الامارات العربية المتحدةجميع حقوق الطبع و الملكية الفكرية محفوظة لشركة

 5. ستظهر لنا هذه النتيجة 
 و هي غير مظبوطة بعض الشئ ..

و للتعديل عليها نختار القيم 
الموضحة من Blend Options كما 

هو موضح بالصورة

ملف العمل النهائي موجود في 
 ملفات عمل المحاضرة السابعة

Replace spine.ai

Blend تابع مع المحاضر كيفية رسم الشكل الموضح بالصورة باستخدام الـ

  المحاضرة الثامنة 

أهداف المحاضرة
• 	Brushes الفرش
• 	Calligraphic Brush .1 	 

Art Brush.2 	 
Scatter Brush .3 	 
Pattern Brush .4 	 
Bristtle Brush .5 	

• 	Pencil tool 
• 	Blend 

المحاضرة السابعة
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CC دبلومة الجرافيكساليستريتور 
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Effects
تعتبر قائمة Effect واحدة من أهم قوائم البرنامج و فيما يلي سنستعرض أهم 

الأوامر الموجودة.

3D

يوجد الأمر 3D  في قائمة Effect و ينقسم إلي 3 أنواع : 

Extrude & BevelRevolveRotate

Extrude & Bevel

كلمة Extrude معناها امتداد و كلمة Bevel معناها حافة 
 1. نرسم شكل مربع 

 Effect 2. نختار من قائمة 
Effect > 3D > Extrude & Bevel 
Dialogue box فيظهر لنا هذا الـ

يمكننا أيضاً تطبيق الـ 3D علي نص و ليس فقط علي الأشكال

سيقوم المحاضر بشرح مفصل لكل الأوامر الموجودة أمامنا

Revolve

كلمة Revolve معناها دوران شكل حول نفسه .

1. نرسم خطاً بأداة الـ Pen tool كما بالصورة 

 Effect 2. نختار من قائمة 
 Effect > 3D >  Revolve 

Dialogue box فيظهر لنا هذا الـ 
OK 3. نضغط

4. تظهر لدينا هذه النتيجة

سيقوم المحاضر بشرح مفصل لكل الأوامر الموجودة أمامنا

المحاضرة الثامنة المحاضرة الثامنة
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ITC جميع حقوق الطبع و الملكية الفكرية محفوظة لشركة ITC أبراج الفالكون - عجمان -الامارات العربية المتحدةأبراج الفالكون - عجمان -الامارات العربية المتحدةجميع حقوق الطبع و الملكية الفكرية محفوظة لشركة

تطبيق عملي ..

تابع مع المحاضر كيفية عمل هذا الشكل 

 Effect للتعديل علي أي شكل طبقنا عليه
 Appearance Panel نفتح الـ 

Window من قائمة

 Effect للتعديل علي الـ 
Apearance نذهب الي قائمة

Effect و نضغط كليك علي اسم الـ

Rotate

 1. نرسم شكل مربع 
 Effect 2. نختار من قائمة 

 Effect > 3D > Rotate 
Dialogue box فيظهر لنا هذا الـ

3. تظهر لدينا هذه النتيجة

Distort & Transform

Pucker & Bloat

Transform و Pucker & Bloat سنشرح في هذا الجزء كلًا من

Effect > Distort and Transform > Pucker and Bloat

 1. نرسم شكل سداسي 
.. Effect 2. من قائمة 

Effect > Distort and Transform > Pucker and Bloat 
Effect 3. ستظهر لنا اعدادات الـ

المحاضرة الثامنة المحاضرة الثامنة
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CC دبلومة الجرافيكساليستريتور 
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TransformStylize

Drop Shadow ظل خارجي

Feather نعومة الحواف

Outer glow وهج خارجي

Round corners حواف مستديرة

Inner glow وهج داخلي 

هذا الـ Effect يعمل علي نسخ الشكل و عمل دوران أو تكبير أو تصغير لهذه النسخ
 1. نرسم دائرة . 

.. Effect 2. من قائمة 
Effect > Distort and Transform > Transform 

Effect 3. ستظهر لنا اعدادات الـ

نحدد عدد النسخ من 
Copies 

 Move و نغير قيم الـ 
Scale و الـ 

Rotate و الـ 
فنحصل علي شكل كما 

هو موضح بالصورة.

باستخدام أداة الـ Flare tool يمكننا رسم هذا الشكل 

 يحتوي الـ Stylize علي العديد من التأثيرات الهامة .
 Effect > Stylize

المحاضرة الثامنة المحاضرة الثامنة
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Scribble

Warp

 هي نفس أوامر الـ warp الموجودة في الفوتوشوب
Effect > Warp

 نرسم مستطيلًا 
 Warp و نطبق عليه التأثير 

و سنجد كل اختيارات الـ Warp موجودة 
في القائمة الفرعية المشار اليها في 

الصورة.

Graphic style

 هي مجموعة من التأثيرات يتم حفظها لاستخدامها علي اي شكل او نص .
Window > Graphic style

إذا رسمنا أي شكل أو كتبنا أي كلمة نستطيع أن نطبق عليها Graphic style من 
الموجودة كما هو موضح بالصورة .

Library الموجودة بالمكتبة Graphic Style يوجد لدينا العديد من الـ

المحاضرة الثامنة المحاضرة الثامنة
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Expand appearance

  معني كلمة Expand appearance هو تحويل الـ Effect إلي شكل .
 مثال : 

 إذا رسمنا شكل سداسي 
 وطبقنا عليه تأثير Pucker & Bloat و الذي سبق و أن شرحناه 

ستظهر لدينا هذه النتيجة .

كل ما يعرفه الأليستريتور الآن هو أن هذا 
الشكل عبارة عن شكل سداسي تم تطبيق 

Effect عليه و لا نستطيع التحكم في 
الوردة نفسها .

و لتحويل الـ Effect إلي شكل نختار من 
Expand Apearance الأمر Object قائمة

  المحاضرة التاسعة 

أهداف المحاضرة

المحاضرة الثامنة

• التعامل مع الصور	
• 	Linked & Embed  
• 	Image Trace 
• 	Mesh tool 
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التعامل مع الصور
في الأساس برنامج الاليستريتور هو برنامج Vector بمعني أنه لا يوجد به أوامر 

 للتعامل مع البكسلات أو الصور .
لكن يمكننا إضافة صورة إلي تصميم و ربط هذه الصورة ببرنامج الفوتوشوب .

 كلمتان في غاية الأهمية و يجب معرفة معني و اهمية كلًا منهما .
ما معني أن الصورة Linked أو Embed ؟؟

 File > Place عند إدخال الصورة عن طريق 
 نلاحظ ظهور علامة ) X (  علي الصورة .

 Linked معني ذلك أن الصورة 
Control Panel و تظهر لنا هذه الاختيارات في الـ

Linked به صور Ai إذن ما هي المشكلة التي ستواجهنا عند العمل علي ملف 
 علي الرغم من أننا لدينا ميزة بارتباط الصورة بالفوتوشوب .

سنشرح ذلك بالتفصيل علي مثال عملي ...

Place الأمر File لادخال صورة للبرنامج نختار من قائمة 
 File > Place

 سنجد الصورة التي نشرح عليها في ملفات عمل المحاضرة التاسعة 
Adobe illustrator cover.psd

Links Panel نفتح Window من قائمة

تعديل علي 
الصورة في 
الفوتوشوب

تحديث 
أي تعديل 

يحدث في 
الصورة

تنشيط 
الصورة في 

التصميم

استبدال 
الصورة 

الموجودة 
بصورة أخري

 Links panel تحتوي الـ
علي كل الصور الموجودة 

في التصميم.

Linked & Embed

Linked معني

Embed Linked

  Ai الصورة أصبحت جزء من ملف الـ
و غير مرتبطة بالفوتوشوب لذلك لا 

 Ai يستلزم أن ننقل الصور مع ملف الـ
من مكان لمكان .

الصورة لا زالت مرتبطة بالفوتوشوب 
و يمكن تعديلها عليه لكن الصورة 

 Ai ليست جزءاً من ملف الـ 
و المشكلة هنا أننا مضطرين لنقل 

 Ai الصور مع ملف الـ

Embed و متي توكن linked ناقش مع المحاضر متي توكن الصورة

تحويل الصورة 
الي embed أي 
انها توكن جزء 

Ai من ملف الـ

تعديل 
الصورة علي 
الفوتوشوب

تطبيق تأثير 
تحويل الصورة 

من بكسلات الي 
Vector

التحكم في 
اطار الصورة

المحاضرة التاسعة المحاضرة التاسعة
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ITC جميع حقوق الطبع و الملكية الفكرية محفوظة لشركة ITC أبراج الفالكون - عجمان -الامارات العربية المتحدةأبراج الفالكون - عجمان -الامارات العربية المتحدةجميع حقوق الطبع و الملكية الفكرية محفوظة لشركة

 نفتح ملف missing.Ai الموجود في ملفات عمل المحاضرة التاسعة 
.Dialogue box سيظهر لنا هذا الـ

إذا اختارنا Ignore سيفتح الملف و لكن سيظهر هذا الاطار الذي يدل علي وجود 
Links Panel صورة مفقودة و سنلاحظ العلامة الحمراء الموجودة في الـ

 Relink نضغط علي علامة 
 ليظهر لنا هذا الـ Dialogue box و الذي يتيح البحث عن الصورة في الكمبيوتر 

 أو استبدالها بصورة جديدة
 سنجد الصورة في ملفات عمل المحاضرة التاسعة.

 لتحويل الصورة إلي Embed - جزء من ملف الـ Ai دون ارتباطها ببرنامج الفوتوشوب

 Control panel عند تحديد الصورة بأداة السهم الأسود و نختار من الـ

 Dialogue box سيظهر لنا هذا الـ 
  والذي يحدد مواصفات تحويل الصورة 

Embed إلي Linked من

و ستتحول كل الـ Layers الموجودة 
في الفوتوشوب الي Layers في 

الاليستريتور كما هو موضح بالصورة.

 و سنجد هذه العلامة بجانب الصورة 
Links panel في

Embed معني

المحاضرة التاسعة المحاضرة التاسعة
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ITC جميع حقوق الطبع و الملكية الفكرية محفوظة لشركة ITC أبراج الفالكون - عجمان -الامارات العربية المتحدةأبراج الفالكون - عجمان -الامارات العربية المتحدةجميع حقوق الطبع و الملكية الفكرية محفوظة لشركة

. Vector كفرة هذا الأمر هو تحويل البكسلات إلي 
 Image Trace نحدد الصورة بأداة السهم الأسود وسنجد الامر 

Control panel في الـ

نجد أن الصورة تحولت الي الشكل الذي أمامنا .

للتحكم في إعدادات الـ Image Trace نضغط علي ايوكنة         
 Control panel الموجودة في  الـ

 Image trace سيظهر لنا اعدادات الـ

بعض النتائج : Image Trace

المحاضرة التاسعة المحاضرة التاسعة
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ITC جميع حقوق الطبع و الملكية الفكرية محفوظة لشركة ITC أبراج الفالكون - عجمان -الامارات العربية المتحدةأبراج الفالكون - عجمان -الامارات العربية المتحدةجميع حقوق الطبع و الملكية الفكرية محفوظة لشركة

 تستخدم هذه الأداة في تلوين شكل بألوان متعددة 
Mesh lines عن طريق شبكة خطوط

 Fill 1. نرسم دائرة و نختار لها لون 
Fill ملحوظة هامة : لا تعمل علي هذه الأداة علي شكل ليس له      

2. نختار أداة الـ Mesh tool و نضغط كليك في أي مكان علي الدائرة.

سيظهر لنا خط طولي و خط عرضي كما هو موضح بالصورة .
3. نختار أي لون من Swatches panel سنجد أن نقطة تقاطع الخطين قد تم 

تلوينها باللون الذي اختارناه .

Mesh tool

طريقة استخدام الأداة

 لاضافة خطوط و نقط أخري نضغط كليك 
 في أي مكان .

و لالغاء نقط أو خطوط نضغط علي النقط 
) Alt + كليك  (

 ملحوظة : 
لتحديد نقطة علي شبكة الخطوط نستخدم أداة السهم الأبيض و لتحديد أكثر 

 من نقطة نستخدم أداة الـ Lasso tool كما هو موضح بالصورة 
ثم نختار لون أي لون لتلوين النقط التي اختارناها.

المحاضرة التاسعة المحاضرة التاسعة
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ITC جميع حقوق الطبع و الملكية الفكرية محفوظة لشركة ITC أبراج الفالكون - عجمان -الامارات العربية المتحدةأبراج الفالكون - عجمان -الامارات العربية المتحدةجميع حقوق الطبع و الملكية الفكرية محفوظة لشركة

تطبيق عملي ..

Mesh tool تابع مع المحاضر  رسم هذه الصورة مرة أخري باستخدام أداة الـ

الصورة موجودة في 
ملفات عمل المحاضرة 

 التاسعة 
mesh tool. jpeg

  المحاضرة العاشرة 

أهداف المحاضرة
• 	Prespective Drawing الرسم المنظوري
• 	Prespective grid tool طريقة استخدام أداة الـ 
• 	Symbols 
• 	Symbols أدوات التعامل مع الـ 
•  المشروع النهائي .	

المحاضرة التاسعة
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ITC جميع حقوق الطبع و الملكية الفكرية محفوظة لشركة ITC أبراج الفالكون - عجمان -الامارات العربية المتحدةأبراج الفالكون - عجمان -الامارات العربية المتحدةجميع حقوق الطبع و الملكية الفكرية محفوظة لشركة

Prespective Drawing الرسم المنظوري
كلمة Prespective معناها منظور و الذي يعطي العين الشعور بالبعد الثالث و 

العمق في الصورة.

وظيفتها اظهار خطوط دليل المنظور 
و التي نقوم برسم العناصر عليها

وظيفتها تحريك العناصر علي خطوط 
دليل الشكل المنظوري

لدينا أداتين في برنامج الاليستريتور تقومان برسم الشكل المنظوري و التحكم 
فيه.

عند اختيار أداة الـ Pprespective grid tool سيظهر لنا خطوط دليل المنظور و 
هي خطوط وهمية لاتظهر في الطباعة .

Widget سنجد في اعلي يسار التصميم مبدل اسطح المنظور 

لاخفاء خطوط الدليل المنظوري نضغط علي علامة الـ ) X ( المشار اليها في الصورة

 Prespective grid tool 1. نختار أداة الـ 
 2. تظهر لنا خطوط الدليل المنظوري

 3. نحدد من الـ Widget مبدل اسطح المنظور ..المربع البرتقالي . 
 4. نختار أداة الـ Rectangle tool و نرسم مستطيل 

5. سنلاحظ رسم المستطيل علي الجانب الايمن ) البرتقالي ( و هو ما حددناه 
 من مبدل اسطح المنظور 

 Grid 6. لتحريك المستطيل علي نفس الـ 
Prespective selection tool نختار أداة الـ

Prespective grid tool طريقة استخدام أداة الـ

تطبيق عملي ..

1. نفتح ملف Prespective selection tool الموجود في ملفات عمل المحاضرة 
العاشرة.

 2. نختار أداة
 الـ Prespective grid tool لاظهار 

 خطوط الدليل المنظوري
 3. نختار أداة 

 Prespective selection tool الـ
لتحريك الشكل علي المنظور 

المحاضرة العاشرة المحاضرة العاشرة
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ITC جميع حقوق الطبع و الملكية الفكرية محفوظة لشركة ITC أبراج الفالكون - عجمان -الامارات العربية المتحدةأبراج الفالكون - عجمان -الامارات العربية المتحدةجميع حقوق الطبع و الملكية الفكرية محفوظة لشركة

للتبديل بين اسطح المنظور نستخدم الارقام 1 و 2 و 3 و 4

 يوجد لدينا شبكات منظور سابقة الاعداد موجودة بالبرنامج
 View > Prespective grid 

1

2

3

4

تطبيقات يتم تنفيذها 

يمكننا اعادة رسم 
هذه النماذج مرة 

أخري و هي موجودة 
في ملفات عمل 

المحاضرة العاشرة.

المحاضرة العاشرة المحاضرة العاشرة
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ITC جميع حقوق الطبع و الملكية الفكرية محفوظة لشركة ITC أبراج الفالكون - عجمان -الامارات العربية المتحدةأبراج الفالكون - عجمان -الامارات العربية المتحدةجميع حقوق الطبع و الملكية الفكرية محفوظة لشركة

Symbols
 هي مجموعة من الأشكال الجاهزة الموجودة داخل البرنامج

 Symbols panel و كل هذه الأشكال موجودة في 
 Window > symbol

 Symbols لدينا مكتبة كبيرة من الـ 
Library موجودة في

 لاستخدام أي Symbol نسحبه من 
الـ Symbols panel الي داخل التصميم

للتعديل علي أي Symbol نحدده أولًا بأداة السهم الأسود 
Control panel فيظهر لنا في الـ

Symbol تعديل الـ  Symbol تحويل الـ
الي شكل عادي

Symbols أدوات التعامل مع الـ

 يمكننا استخدام أدوات الـ Symbols في توزيع و تكبير و تصغير و تغيير كثافة
Symbols  و لون الـ 

و فيما يلي جدول يوضح كل أداة و وظيفتها.

الوظيقة اسم الأداة الأداة

 إضافة مجموعة
Symbol Sprayer tool من الـ Symbols إلي التصميم

Symbols تحريك الـ Symbol Shifter tool
 زيادة أو تقليل المسافات بين

Symbols الـ Symbol Scruncher tool

Symbols تكبير أو تصغير الـ Symbol Sizer tool
Symbols عمل دوران للـ Symbol Spinner tool

Symbols التحكم في ألوان الـ Symbol Stainer tool
 Opacity التحكم في مقدار الـ

Symbols للـ Symbol Screener tool

Graphic style تطبيق 
Symbols علي الـ Symbol Styler tool

Symbols تابع مع المحاضر كيفية التعامل مع أدوات الـ

المحاضرة العاشرة المحاضرة العاشرة
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ITC جميع حقوق الطبع و الملكية الفكرية محفوظة لشركة ITC أبراج الفالكون - عجمان -الامارات العربية المتحدةأبراج الفالكون - عجمان -الامارات العربية المتحدةجميع حقوق الطبع و الملكية الفكرية محفوظة لشركة

Final Project المشروع النهائي
المحاضرة العاشرة المحاضرة العاشرة

 المطلوب هو تصميم مجموعة مطبوعات لشركة 
Talent landscape 

 و هي شركة متخصصة في تصميم الحدائق و البحيرات الصناعية و أرضيات الرخام 
و الشلالات الصناعية و وحدات الاضاءة.

 المطلوب : 
 1. تصميم لوجو جديد للشركة .

2. تصميم مطبوعات الشركة و الموضحة بالصورة .

Business card
كارت شخصي

90 mm

50 mm

Letter Head
ورقة المكاتبات

A4

210 mm

297 mm

220 mm

110 mm

Envelope
ظرف 

210 mm

297 mm

A4

Bruchor
مطوية

C 0
M 100
Y 100
K 25

C 50
M 0
Y 100
K 0

 ملفات العمل و المقاسات 
و الصور موجودة بملف 
عمل المحاضرة العاشرة.


